CONTENTS

- Field of Application
- Installation on Windows
- Installation on Mac
- Activation
- License Comparison
- Workspace
- Using the Program
- Drawing
- Timeline
- Toolbar
- Canvas
- Frames
- Text
- Presets
- Preferences
- Batch Processing
- Print Image
- Gallery of Works
- Charcoal Sketch
- AKVIS Programs
AKVIS Charcoal is an artistic tool for conversion of photos into charcoal and chalk drawings.

**Charcoal** is one of the most popular materials for drawing. It lets you create a preliminary sketch as well as a finished work of art. It combines the advantages of different materials and can be used together with different drawing tools. Using the sharpened charcoal you can make thin clear lines, but if you put it on the edge you’ll get a wide loose stroke. Charcoal creates rich and easy picturesque strokes, both delicate and bold.

**Chalk** is one of the first creative tools for kids. It is ideal for sketching and creating large drawings on pavement or tinted paper. White chalk is used to highlight bright areas of the image, add accents, and give the picture volume.
AKVIS Charcoal allows you create drawings with each material or combine them using dramatic contrast between black and white. Playing with colors and options, you can get a lot of variants of photo to drawing conversion and achieve outstanding artistic effects such as *sanguine*.

You can observe the conversion of your photo into a charcoal and chalk drawing in real time. The program makes snapshots during processing and lets you choose between them. Thanks to this magnificent feature it’s possible to create variations of drawings without adjusting the settings.

Changing the color of the background paper gives even more variants of the final result. To make a drawing more authentic it’s possible to apply a variety of canvas textures. Adding your signature to an image you can feel like a real artist, the author of a work of art.
The program offers a list of presets, ready-to-use settings combinations which make it easier to work with the software and save you time. You can create your own presets saving your favorite combinations of the parameters.
AKVIS Charcoal is available as a *standalone* program and as a *plugin* to a photo editor, for Windows and Mac.

The plug-in is compatible with Adobe Photoshop, Photoshop Elements, Corel Paint Shop Pro, etc. [Consult the compatibility page](#) for more details.

The *functionality* of the program depends on the license type. During the trial period you can try all options and choose the license you like.
Follow the instructions to install **AKVIS Charcoal** in Windows.

- Start the setup **exe** file.
- Select your language and press the **OK** button to launch the installation process.
- To continue the installation process you have to read and accept the **License Agreement**.

  Activate the check box "**I accept the terms in the license agreement**", and press **Next**.

- To install the **Plugin** you should select your photo editor(s) from the list.

  **Hint:**
  If your photo editor is not in the list, activate the component **Custom Plugins Directory** and choose the folder where you keep all plugins and filters, for example, **C:\My Plugins**. In this case you should set this folder as the plugins folder in the settings of your photo editor.

  Or you can copy the **8bf** file into the Plug-ins folder of your image editor.

To install the **Standalone version**, make sure that the check-box **Standalone** is activated.
To create a shortcut for the program on desktop, activate the component **Shortcut on Desktop**.

Press the button **Next**.
• Press the button **Install**.

• The installation is in progress.
The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates and events.

- Press Finish to exit Setup.

After installation of the standalone version of Charcoal, you will see a new line in the Start menu: AKVIS - Charcoal and a shortcut on desktop, if during installation the component Shortcut on Desktop was enabled.
After installation of the Charcoal plugin you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop: Filter -> AKVIS -> Charcoal. Please use this command to launch the plugin in the editor.
INSTALLATION

Follow the instructions to install AKVIS Charcoal in a Mac computer:

- Open the virtual disk dmg:
  - akvis-charcoal-app.dmg to install the Standalone version
  - akvis-charcoal-plugin.dmg to install the Plugin to your image editor (Photoshop or Photoshop Elements).
- Read the License Agreement and press Agree, if you agree with the conditions.

Finder will open with AKVIS Charcoal application or AKVIS Charcoal PlugIn inside.

- To install the Standalone version just drag the AKVIS Charcoal application into the folder Applications (or any other place you like).

To install the Plugin drag the entire AKVIS Charcoal PlugIn folder into the Plug-Ins folder of your graphic editor.

For example:

  if you use Photoshop CC 2018, copy the plugin into Applications/Adobe Photoshop CC 2018/Plug-Ins;
  if you use Photoshop CC 2017, copy it into Applications/Adobe Photoshop CC 2017/Plug-Ins;
  if you use Photoshop CC 2015.5, copy it into Library/Application Support/Adobe/Plug-Ins/CC;
  if you use Photoshop CC 2015, copy it into Applications/Adobe Photoshop CC 2015/Plug-ins;
  if you use Photoshop CS6, copy it into Applications/Adobe Photoshop CS6/Plug-ins.
After installation of the plugin, you will see a new item in the Filter menu of your photo editor. In Photoshop select in menu: **Filter -> AKVIS -> Charcoal.**

Run the standalone app by double-clicking on its icon in Finder.
HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet. If it is not possible, we offer you an alternative way (see below for Offline Activation).

Download AKVIS Charcoal and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the number of days left in your trial period.

You can also open the About the Program window by pressing the button 🛠️ in the program's Control Panel.

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types: Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

Click on ACTIVATE to start the activation process.
Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

**Direct connection:**

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press **ACTIVATE**.

Your registration is completed!

**Request by e-mail:**

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

**NOTE:** You can also use this method for **Offline Activation**:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for example, with a USB stick. Send us this information to: activate@akvis.com.

**Please do not send the screenshot!** Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (**Charcoal.lic**) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the **AKVIS** folder in Users' Shared (Public) Documents:

- **Windows Vista/7/8/10:**
  
  Users\Public\Documents\AKVIS;

- **Windows XP:**
  
  Documents and Settings\All Users\Documents\AKVIS;

- **Mac:**
  
  Users/Shared/AKVIS.
Your registration is completed!

When the program is registered, **BUY NOW** turns to **UPGRADE** that lets you improve your license (for example, change **Home** to **Home Deluxe** or **Business**).
Using **AKVIS Charcoal** you can transform your photos into charcoal and chalk drawings. The product is available as a standalone application and as Photoshop compatible plugin.

The functionality of the software depends on the license type. Some features are only available for **Deluxe** and **Business** licenses.

<table>
<thead>
<tr>
<th>License Comparison:</th>
<th>Home (Plugin)</th>
<th>Home (Standalone)</th>
<th>Home Deluxe (Plugin+Standalone)</th>
<th>Business (Plugin+Standalone)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non-commercial use</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>commercial use</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standalone</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Features</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Charcoal &amp; Chalk Effect</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Tools:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Crop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stroke Direction Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Post-Processing Tools</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Additional Features:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timeline</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Canvas</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Frames</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Presets</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Import/Export Files:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.charcoal (Presets)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>*.direction (Guiding lines)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Batch Processing</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Share</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Large Format Print</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXIF, IPTC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Color Space</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RGB</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CMYK</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Function</td>
<td>Windows</td>
<td>Mac</td>
<td>10-days trial</td>
<td>Price</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------</td>
<td>-----</td>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td>Lab</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>$ 49</td>
</tr>
<tr>
<td>Grayscale</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>$ 49</td>
</tr>
<tr>
<td>8 / 16 bits</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>$ 69</td>
</tr>
<tr>
<td>32 bits</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>$ 89</td>
</tr>
<tr>
<td><strong>Image Format</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIFF</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>JPEG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>BMP</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>PNG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>RAW</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>DNG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>PSD</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>OS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Mac</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td><strong>Price</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>$ 49</td>
<td>$ 49</td>
<td>$ 69</td>
<td>$ 89</td>
<td></td>
</tr>
</tbody>
</table>
AKVIS Charcoal converts a digital photo into a drawing made with charcoal and chalk. This artistic software can be used independently as a standalone program or in a photo editor as a plugin filter.

Standalone is an independent program; you can open it by clicking on the program's icon.

To launch the standalone version, run the program directly:

On a Windows computer - select it from the Start menu or use the program's shortcut.

On a Mac computer - launch the app from the Application folder.

Plugin is an add-on for a photo editor, for example for Photoshop.

To call the plugin, select it from filters of your image editing program.

The program's workspace looks like this:

The left part of the AKVIS Charcoal window is taken by the Image Window with two tabs: Before and After. The Before tab shows the original photo, the After tab - the result. You can switch between them by left-clicking on the tab with mouse button. To compare the original and the resulting images, click on the image and hold the button pressed - the program will currently switch between tabs.

In the upper part of the program's window you can see the Control Panel.

The button opens the home page of AKVIS Charcoal.

The button is used for managing the loading operations.

Right mouse click on this button displays the list of recent images. You can change their number in the program's Preferences.

Left mouse click shows the list of the commands:
The button (available only in the standalone version) - It opens an image. The hot-keys are Ctrl + O on Windows, ⌘ + O on Mac.

The button - It loads saved guiding lines (.direction file).

The button - It loads a list of presets (.charcoal file).

The button shows the list of the saving commands:

The button (available only in the standalone version) - It saves the image in the chosen format. The hot-keys are Ctrl + S on Windows, ⌘ + S on Mac.

The button - It saves the guiding lines to a .direction file.

The button - It saves user presets to a file with the .charcoal extension.

The button (only in the standalone version) calls the Print dialog box. The hot-keys are Ctrl + P on Windows, ⌘ + P on Mac.

The button lets posting pictures from the program to the social networks: Twitter, Flickr, Tumblr, Google+.

The button shows/hides the guiding lines.

The button cancels the last operation (with the tools). It is possible to cancel several operations in a row. The hotkeys are Ctrl + Z on Windows, ⌘ + Z on Mac.

The button returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys are Ctrl + Y on Windows, ⌘ + Y on Mac.

The button (only in the standalone version) opens the Batch Processing dialog to automatically process a series of images.

The button initiates image processing with the current settings. The resulting image is shown in the After tab.

The button (only in the plugin version) applies the result to the image and closes the plugin.

The button shows information about the program: version, trial period, license.

The button calls the Help files. The hot-key is F1.

The button calls the Preferences dialog box for changing the program’s options.

To the left of the main window there is the Toolbar. Different tools appear depending on the active tab, Before or After. The tools are divided into the groups: pre-processing (in the Before tab), post-processing (in the After tab), and additional tools (available in both tabs).
You can navigate and scale the image using the **Navigator**. The frame in the **Navigator** surrounds the area of the image which is visible in the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

![Navigator](image)

To scroll the image in the **Image Window** you can press the spacebar on the keyboard and drag the image with the left mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the `Ctrl` key pressed – to the left/to the right, by keeping the `Alt` key pressed – scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider or the buttons + and −, to scale the image. When you click on the + button or move the slider to the right, the image scale increases. When you click on the − button or move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some frequently used coefficients.

You can use hot-keys to change the image scale + and `Ctrl`+ + (⌘+ + in Mac) to increase the image scale and − and `Ctrl`+− (⌘+− in Mac) to reduce the scale.

Under the **Navigator** there is the Settings Panel with the **Drawing** and **Decoration** tabs:

**Drawing**: Here you can adjust the settings for photo-to-painting conversion.

**Decoration**: You can add text to your image, adjust the canvas, and apply a frame.

Below, in the **Presets** field you can save the current settings as a preset to use them in the future. The current settings can be saved, edited, deleted. When you launch the program, it uses the settings of the last used preset.

Under the **Settings Panel** you can see **Hints** for the parameters and buttons when you hover over them with the cursor. You can choose where the hints will be shown or hide them in the program's **Preferences**.
AKVIS Charcoal lets you transform a photograph into a charcoal and chalk drawing. The software can be used independently as a standalone program or as a plugin filter in a photo editor.

The functionality of the software depends on the license type. Consult the comparison table. During the trial period you can try all options and choose the license you like.

To create a drawing from your photo, follow these instructions:

**Step 1.** Open an image.

- If you work with the standalone edition:
  
  The dialog box **Select File to Open** appears if you double-click on the empty workspace of the program or if you click on \( \text{open} \) then on \( \text{open} \). Use the hot-keys: \( \text{Ctrl} + \text{O} \) on Windows, \( \text{⌘} + \text{O} \) on Mac.
  
  You can also drag the required image into the workspace of the program.
  
  The standalone program supports JPEG, RAW, PNG, BMP, and TIFF file formats.

- If you work with the plugin:

  Open an image in your photo editor by calling the command **File -> Open**.

  Call the plugin from the menu of the editor:

  - in **Adobe Photoshop** and **Photoshop Elements** - **Filter -> AKVIS -> Charcoal**;
  - in **Corel PaintShop Pro** - **Effects -> Plugins -> AKVIS -> Charcoal**;
  - in **Corel Photo-Paint** - **Effects -> AKVIS -> Charcoal**.

**Step 2.** In the standalone version, before applying the effect, you can cut off unwanted areas of the picture and improve its composition with the **Crop** tool.

If you use the plugin, you can do this in your image editor.
Step 3. Adjust the effect settings in the **Drawing** tab. You can choose one of the **presets** or set the parameters to your liking.

The result will be immediately shown in the **quick preview window** which is visible in the **Before** tab if the button in the Toolbar is pressed.
**Step 4.** To convert the entire image into a charcoal and chalk drawing press the button 
.
The progress bar appears over the image, with the icon (to make a snapshot) and the Stop button (to interrupt the process).

**Step 5.** You can improve the result of the automatic photo-to-drawing conversion with the Stroke Direction tool.

*Note:* This feature is only available for the advanced licenses (Home Deluxe and Business).

Draw guiding lines with the tool and click on to re-process the image.

**Step 6.** To make your drawing even more realistic you can use the Decoration options: Canvas, Frame, and Text.

*Hint:* The order of the application of the decoration effects depends on the position of the tabs. Drag the tabs to change the order.
Step 7. If you like your new settings, you can save them as a preset and use them later. Type a name for the preset into the Presets field and press Save.

When a new preset is created, it will be available in all tabs and will contain their settings.

Step 8. During the image processing, the program creates a list of intermediate shots which represent different stages of conversion - from a semi-processed sketch to a practically finished work. They are displayed in the Timeline at the bottom of the main window. You can choose any of the intermediate results by clicking on it. The last image is the final result.

Note: This feature is only available for the Home Deluxe and Business licenses.

You can also add your favorite moments of image processing to the Timeline by taking a snapshot with the button that is located right of the progress bar. Read more.

Step 9. You can edit the result and put the finishing touches to your drawing with the post-processing tools: Charcoal, Chalk, Eraser, and History Brush.

Note: These tools are only available for the Home Deluxe and Business licenses.

Hint: Use the post-processing tools at the final step! If you run the processing again, the changes made with the tools will be lost.

Step 10. Share your drawing by clicking on . It opens the list of the services where you can publish the image: Twitter, Flickr, Tumblr, Google+.

In the standalone version, you can also print your result using .

Step 11. Save the processed image.

- If you work with the standalone edition:

  Click on then on to open the Save As dialog box. You can use the hot-keys: Ctrl+S on Windows, ⌘+S on Mac. Enter a name for the file, choose the format (TIFF, BMP, JPEG or PNG) and indicate the target folder.
- If you work with the plugin:

Press the button ✓ to apply the result and close the plugin window. The **AKVIS Charcoal** plugin will close and the picture will appear in the workspace of the photo editor.

Call the **Save As** dialog box using the command **File -> Save As**, enter a name for the file, choose the format and indicate the target folder.
**Charcoal and Chalk Drawing**

**AKVIS Charcoal** transforms your photos into charcoal and chalk drawings.

**Charcoal** is one of the most popular materials for drawing. It lets you create a preliminary sketch as well as a finished work of art. It combines the advantages of different materials. Using the sharpened charcoal you can make thin clear lines, but if you put it on the edge you’ll get a wide loose stroke.

**Chalk**, in its traditional white color, is used to highlight bright areas of the image, add accents, and give the picture volume.

Using both tools you can create professional-looking expressive black and white images. It's also possible to play with colors to achieve outstanding artistic effects, such as sanguine or others.

Charcoal and Chalk Drawing From Photo
Adjust the effect settings in the **Drawing** tab:

**Paper Color.** Change the color of the paper by clicking on the color plate.

Using the **Charcoal** and **Chalk** check boxes, you can choose what tools will be used for drawing - both or one of them.

You can select colors for the charcoal and chalk strokes with the color plates.

Note that these colors will also be used for the **post-processing tools** and .

**Outlines.** This additional option works if both drawing materials are active. When the check-box is enabled, extra chalk lines appear along the contrasting borders over the charcoal strokes.

**Simplicity** (0-10). The parameter controls pre-processing of the image, removing noise and microdetails, smoothing out weak gradients.
Simplicity = 2
Simplicity = 8

**Stroke Thickness** (10-100). The parameter defines the maximum width of the strokes.

Stroke Thickness = 20
Stroke Thickness = 70

**Stroke Length** (10-100). The parameter sets the maximum length of the strokes.

Stroke Length = 10
Stroke Length = 50
**Stroke Intensity** (0-100). The parameter changes the perceptibility of the strokes. Lower values result in weaker and softer strokes. At higher values more pigments are concentrated into each stroke, so the lines become more noticeable.

![Stroke Intensity](image)

**Stroke Density** (10-100). The parameter affects the number of the strokes. The higher the value, the fewer areas will remain unpainted.

*Note:* High values of this parameter will significantly increase processing time.

![Stroke Density](image)

**Threshold** (0-100). The parameter controls the distribution of the charcoal and chalk lines and unpainted zones.

![Threshold](image)

**Smoothing** (0-100). When increasing the parameter, the transitions between the strokes become smoother.
**Chalk Hatching** (10-100). The parameter adds the chalk strokes in light areas.
In **AKVIS Charcoal** you can observe the conversion of your photo into a charcoal and chalk drawing in real time. During the process, the program creates a list of intermediate shots which represent different stages of conversion — from a semi-processed sketch to a practically finished work. Without changing the settings you can create variations of drawings and choose any of them.

The **Timeline** is displayed at the bottom of the main window.

![AKVIS Charcoal](image)

**Attention:** The **Timeline** feature can only be used by owners of **Home Deluxe** and **Business** licenses. Note that everyone, even with a **Home** license, can get a semi-processed image using the **Stop** button in the progress bar.

Start conversion of your photo into a drawing by pressing the button ![play](image). You will see shots appearing at the bottom of the window in the course of processing.

You can also take snapshots of your favorite moments with the button ![camera](image) right of the progress bar. When you press it the drawing in its current state will be added to the list; such manual shots are selected with the blue frame.
If you press the Stop button in the progress bar, image processing will be interrupted.

Browse the shots in the Timeline to find the image you like most. If you want to get back to your final result, click on the last shot in the list.

When you change the parameters and re-run image processing, the Timeline will be cleaned up and will start being filled up with new shots. You can save some of the variants by pinning them with a double click. In the upper corner of the selected shot appears the icon ■.

You can switch between the shots, change the settings and re-start processing - the pinned result will remain in the list. It’s possible to unpin it with a double click.
Attention! Loading a new image into the program removes all shots, including pinned.

Note:
After using the post-processing tools, switching to another image in Timeline will result in the loss of changes made with the tools. You can save the result under a new name and continue working.

You can hide/show the Timeline in the program's preferences. If the Timeline Shots option is enabled, you can set the number of the shots created during image processing.
In AKVIS Charcoal, different tools become visible depending on the active tab, Before or After.

The tools in the program are divided into the groups: pre-processing (Before tab), post-processing (After tab), and additional tools (Before and After tabs).

Hint:
You can use the buttons \( \text{undo/redo} \) to undo/redo the operations made with the tools:

Pre-Processing Tools (on the Before tab):

Quick Preview \( \text{switches on/off} \) the preview window. It is a square frame outlined with the "marching ants" that displays changes made in the Drawing and Decoration tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you quickly preview the effect in different areas of the image. To compare the result of automatic conversion with the original picture, click and keep mouse pressed within the preview area.

You can adjust the preview window size in the program's preferences.

Crop \( \text{(in the standalone version)} \) lets you cut off unwanted areas in the image. The tool is useful when you want to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and contrariwise.

You can change the crop area by dragging the sides and the angles of the bounding frame.

To apply the result and remove the areas outside the frame, press \( \text{OK} \) or use \( \text{Enter} \). To cancel the operation and exit the tool, press \( \text{Cancel} \) or use the \( \text{Esc} \)-key. To restore the original area keeping the tool...
active, press **Reset** button.

Adjust the crop options:

You can choose the size of the crop rectangle from the **Ratio** drop-down list or enter your custom aspect ratio.

If the **External Area** check-box is enabled, you can change the color and opacity of the outer parts.

**Stroke Direction** gives you full control over the strokes. With this technique you can achieve truly realistic drawings with patterns and textures going in the right direction.

**Note:** This feature is only available for the advanced licenses (Home Deluxe, Business).

Add the **guiding lines** with this tool, and the program will re-make the drawing following the new direction. The changes will be shown in the preview window. To re-start the image processing, click on the button.
**Hint:** You can save and load the guiding lines created with this tool. Loaded lines automatically adapt to the Image size.

**Eraser** lets you edit and remove the guiding lines drawn with the **Stroke Direction** tool. The size of the eraser can be adjusted by right clicking on the image.

**Post-Processing Tools** (on the **After** tab, for Deluxe/Business):

**Attention!** The post-processing tools are only available under the **Home Deluxe/Business** licenses, on the **After** tab. Use them at the final step. If you re-run the image processing, the changes made with the post-processing tools will be lost!

The tools’ options are shown in a pop-up box which appears after right-clicking in the image.

Using the **Charcoal** and **Chalk** tools you can strengthen the hand-made effect and draw soft textured strokes with colors selected in the effect settings.

- **Size** (1-200). The maximum line width which can be drawn with the tool.
- **Strength** (1-100). The impact of the tool.
- **Show Original** (0-80). When increasing the parameter, the original image becomes visible through the effect. This parameter is auxiliary, it is useful for more precise drawing with the tools and does not affect the result.

![Drawing Effect](image1.png) ![Using Tools](image2.png)

**Eraser** lets you erase the charcoal and chalk lines, both generated with the program and drawn with the tools.

- **Size** (1-1000). The maximum width of the transparent line which the eraser leaves behind (in pixels).
- **Hardness** (0-100). The amount of blurriness of the brush's edge. As the value of this parameter increases the edge of the brush becomes harder. Near 100% the border between erased and unerased areas will be more distinct; at lower values the boundary between these areas will be smoother.
- **Strength** (1-100). The amount of influence on an image. As this parameter’s value is increased, the degree of transparency left by the brush increases.
- **Show Original** (0-80). When increasing the parameter, the original image becomes visible through the effect. This parameter is auxiliary, it is useful for more precise drawing with the tools and does not affect the result.
History Brush lets you fade the charcoal and chalk effect and restore the image to its original state. You can choose the mode of the tool: edit all changes or only tools keeping the effect.

The tool's parameters:

- **Restore to Original.** If the check-box is enabled, the tool lets weakening the drawing effect, as well as the result of the post-processing tools. If the check-box is disabled, the brush edits only the tools but does not affect the result of the image processing.

- **Size** (1-1000). The maximum width of a line made by the brush.

- **Hardness** (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges become. At value 100% the border between the brush's edges and the background is very distinct; at lower values the transition between these areas is smoother.

- **Strength** (1-100). The degree of restoration to the original state. At lower values there will be less restoration and more blending with the effect; at value 100% the original image will be restored more completely.

**Additional Tools** (available on both tabs, for all licenses):
**Hand** lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction. The hot-key is **H**.

Double-clicking on the tool’s icon on the Toolbar makes the image fit the window.

**Zoom** lets you change the image’s scale. To zoom in left click on the image. To zoom out left click with **Alt** on the image. The hot-key is **Z**.

Double-clicking on the tool’s icon makes the image scale to 100% (actual size).
CHARCOAL & CHALK DRAWING ON CANVAS

Using **AKVIS Charcoal** you can put your drawing to any surface: sanded paper, brick wall, and others.

In the **Decoration** group switch to the **Canvas** tab and enable the **Use Canvas** check-box.

**Hint:** You can drag the **Canvas/Frame/Text** tabs to change the order of the application of the decoration effects.

You can choose a texture from **Library -> Surface** or load your own sample: **Library -> Custom**...

Adjust the canvas settings.
In **AKVIS Charcoal** you can also add a frame to your charcoal and chalk drawing.

In the **Decoration** group switch to the **Frame** tab, enable the check-box of the same title, and choose the frame style and texture.

**Hint:** You can drag the **Canvas/Frame/Text** tabs to change the order of the application of the decoration effects.

---

You can apply these frames to decorate your drawing:

- **Classic Frame**
- **Pattern Frame**
- **Strokes**
- **Vignette**
- **Passe-Partout**
Adding Text or Watermark to Your Drawing

In **AKVIS Charcoal** you can personalize your charcoal and chalk drawing by adding a signature, a logo, or a watermark.

In the **Decoration** group switch to the **Text** tab and enable one of the modes: **Text** or **Image**.

**Hint:** You can drag the **Canvas/Frame/Text** tabs to change the order of the application of the decoration effects.

Adding Text

You can add any text or image.

Adjust the text/watermark settings.
WORKING WITH PRESETS

AKVIS Charcoal imitates the technique of drawing with charcoal and chalk. The program includes a number of ready to use Presets which help you start working. When moving a cursor over an AKVIS preset in the drop-down list, the sample appears in the small window near the list. They can be applied "as is" or can be modified.

Every effect contains its list of the presets; each preset keeps the settings of all tabs. You can apply one of the AKVIS presets or modify the parameters to achieve the desired result. To process the image with a certain preset, select it from the list and press . To create your own preset, adjust the settings, type a name for the preset, and press Save. To return to the default settings of the selected preset, press Reset. To delete a preset, choose it from the drop-down list and press Delete. The AKVIS built-in presets cannot be removed.

You can save your presets to a .charcoal file with . To load presets from the file use .

Read more how to import and export user presets.
The button opens the **Preferences** dialog box that looks like this:

- **Language.** Change the program language by selecting another from the drop-down list.
- **Interface Scale.** Choose the size of the interface elements. When it is set to **Auto**, the program workspace will automatically scale to fit the screen resolution.
- **Interface Theme.** Select the style of the program interface: **Light**, **Gray**, or **Dark**.
- **Preview Window Size.** Choose the desired value for the size of the quick preview window: from 200х200 px to 1000х1000 px.
- **Processing Size Limit.** Image processing is a very time-consuming operation. This parameter accelerates image processing by temporary reducing the size of the image to be processed. When the file size (in megapixels) does not exceed the defined value, the image is processed in the usual way. If the loaded file is larger, the program will reduce the image, process it and enlarge it again to the initial size.
- **Initial Image Scale.** This parameter defines the way the image is scaled in the main window after loading:
  - **Fit to View.** The scale adjusts so that the image will be completely visible;
  - **100%.** The actual size is used, the image doesn't scale.
- **Timeline Shots.** This option lets you hide/show the **Timeline.** If the check box is enabled, you can set the number of the shots created during image processing.
- **Hints Panel.** You can choose how the hints will be shown:
  - **Under Image Window;**
  - **Under Settings Panel;**
  - **Hide.**
- **Recent Files** (available only in the standalone version). The number of recent documents. The list of the recent files, sorted by time, become visible by right mouse clicking on . Maximum: 30 files.
- **Use OS File Dialog.** Enable this option if you want to use the System Open/Save Dialog. Otherwise, the AKVIS File Dialog is used.
- **Lock the Control Panel.** It disables the possibility to hide/show the top panel. If the check box is selected the panel is always visible.

To apply changes made in the Preferences window press **OK**.
If you need, click on the button **Default** to return to the default settings.
AKVIS Charcoal supports the **Batch Processing** feature that lets you automatically convert in drawings a series of images with the same settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style for a booklet or when processing all frames of video.

Even if you’ve never used this feature before it is simple to learn!

If you use the standalone version of **AKVIS Charcoal**, [read the instructions here.](#)

If you use the **Charcoal** plugin in Photoshop, [use this tutorial.](#)
BATCH PROCESSING WITH PHOTOSHOP PLUGIN

The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This method applies the same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an Action in Photoshop and then apply it to a photo folder.

Follow the instructions:

**Step 1.** Create two new folders, for example: "source-files" and "result-files". Place original images into the "source-files" folder. The results will be saved in the "result-files" folder.

**Step 2.** Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's settings and create an action.

**Step 3.** In the Actions palette click Create New Set button. In the dialog window give a name for a new set of actions, for example, "AKVIS Actions".

If you already have a special set for the AKVIS actions, you can just choose it.

**Step 4.** Press Create New Action and give a name for it, for example, "Neon".
Press the **Record** button, and the recording of the action will immediately start.

**Step 5.** Call the plugin and adjust its parameters.
Step 6. Press the button ✅. The plug-in window will close and the effect will be applied to the image. In the Actions palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As in the File menu and save the image into the destination folder.

Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions palette.

Step 9. Delete the file that you have just saved.

Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.

Step 11. In the Batch dialog window and set the parameters:
   - In the Set drop-down list choose "AKVIS Actions" and the new action.
   - In the Source option set Folder. Press the Choose... button and select "source-files".
As the Open command was not recorded in the action, the **Override Action "Open" Commands** check-box should be deactivated.

For **Destination** select **Folder**, then press the **Choose...** button and select "result-files". Activate **Override Action "Save as" Commands** check-box.

In the **File Naming** section you can create the filenames structure for the resulted images. If you do not want to change the names, in the first combo-box choose **document name**, and in the second - **extension**.

**Step 12.** Press **OK** to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-files" folder, one by one, and will save them to the "result-files" folder.
In the standalone version of **AKVIS Charcoal** you can print the image.
Press the button ![Print button](image) to open the **Print** options.

Adjust the parameters appearing in the **Settings Panel**:

- Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

- In the **Orientation** group, set the position of paper: **Portrait** (vertically) or **Landscape** (horizontally).

- Click the **Page Setup** button to open a dialog box to choose the size of the paper and its orientation, as well as the print margins.

- Press the **Reset Margins** button to return the page margins to the default size.

- Change the size of the printed image adjusting the parameters **Scale**, **Width**, **Height** and **Fit to Page**. These parameters have no effect on the image itself, just on the print version. You can change the size of the printed image by entering any value in %, or by entering new values in **Width** and **Height**.

- To adjust the size of the image to the paper size, select **Fit to Page**.

- Move the image on the page with the mouse or align it using the arrow buttons.

- You can activate **Frame** for the image and adjust its width and color.

- Choose the **Background Color** by clicking on the color plate.

- In the **Page** tab, you can adjust printing of the multiple copies of the image on a single sheet.
Print Page

- **Copies per Page.** It lets you specify the number of copies of the image on one page.
- **Horizontally** and **Vertically.** These parameters indicate the number of rows and columns for the copies of the image on the page.
- **Spacing.** The parameter sets the margins between the copies of the image.

In the **Poster** tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a large picture.

Print Poster

- **Pages.** If the check-box is enabled, you can specify the maximum number of the pages in which the image will be divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).
- **Glue Margins.** If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be added to the right and to the bottom of each part.
- **Lines of Cut.** Activate the check-box to display the cut marks in the margins.
- **Show Numbers.** With the enabled check-box, a sequence number of each part, by a column and a row, will be printed in the margins.
To print the image with the chosen parameters, press the Print button.
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the document to print.
Charcoal, chalk, sanguine are the most ancient drawing materials which were used even by our primitive ancestors for decorating their places. Until now these tools have not lost their relevance, and they are quite popular among professional artists and amateurs.

With AKVIS Charcoal you can turn your photo into a drawing made with charcoal on colored paper, or with chalk on the pavement. You can use both materials to create spectacular artworks. Playing with colors and options, you can get a lot of variants of photo to drawing conversion.

Look at these drawings created from photographs:

Charcoal Drawing (Charcoal is black, Chalk is disabled):

Chalk Drawing (Charcoal is disabled, Chalk is white):

Charcoal and Chalk Drawing (Charcoal is dark blue, Chalk is light yellow):
Sanguine Drawing (Charcoal is red-brown, Chalk is disabled):
**CHARCOAL SKETCH**

Charcoal is expressive and simple material that lets you draw a sketch with a few strokes. Using AKVIS Charcoal you can quickly create a charcoal sketch from your photo.

Read how to transform a photo into a charcoal contour line drawing:

**Step 1.** In AKVIS Charcoal, choose one of the ready-to-use presets or adjust the effect settings. All changes are immediately displayed in the preview window.

**Step 2.** Press the button to launch full image processing. You will see intermediate shots appearing in the Timeline. After processing is complete, you can select your favorite variant of drawing by clicking on it in the Timeline (this feature is only available for Home Deluxe and Business licenses).
Image processing can also be interrupted at any time by pressing the Stop button next to the progress bar (available for all types of licenses).

The result will be shown in the After tab.

**Step 3.** You can edit the result: remove extra lines and add new strokes using the post-processing tools (available for Home Deluxe and Business licenses).

The most useful tool is Eraser [ ] that lets you easily remove unwanted strokes.

**Step 4.** You can also add the canvas texture to your sketch.
AKVIS PROGRAMS

AKVIS Sketch Video — Convert Video to Cartoon
(Windows | Mac)

AKVIS Sketch Video is an After Effects and Premiere Pro plugin for converting videos into animated cartoons, both black and white and color. Apply cartoon effects easily with the Sketch Video plugin! More...

AKVIS AirBrush — Airbrushing Techniques on Your Photos
(Windows | Mac)

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen settings of photo-to-painting conversion. More...

AKVIS ArtSuite — Frames and Effects for Your Photos
(Windows | Mac)

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and texture samples that can be used to create a virtually limitless variety of options for generating frames. Decorate a photo to give it an original and festive look! More...
AKVIS ArtWork — Collection of Painting & Drawing Techniques
(Windows | Mac)

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting, Watercolor, Gouache, Comics, Pen & Ink, Linocut, Pastel. ArtWork helps you to create a piece of art out of any picture! More...

AKVIS Charcoal

AKVIS Chameleon — Photo Collage Creation
(Windows | Mac)

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining.
The tool is very easy to handle as it does not require precise selection of objects. Using the software you can quickly create your own photo collages. More...

AKVIS Charcoal — Charcoal & Chalk Drawings
(Windows | Mac)

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects, such as sanguine and others. More...

AKVIS Coloriage — Add Color to Black and White Photos
(Windows | Mac)

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color photos. Just indicate the desired colors by the stroke of the brush; the program does the rest of the work: recognizes the object’s border and tailors the new color to the grayscale tones of the initial picture. More...
**AKVIS Decorator — Resurface and Recolor**

(Windows | Mac)

**AKVIS Decorator** lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently. Recoloring is also made easy. [More...](#)

**AKVIS Draw — Hand-made Pencil Drawing Effect**

(Windows | Mac)

**AKVIS Draw** converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures! [More...](#)

**AKVIS Enhancer — Bring Detail To Your Pictures**

(Windows | Mac)

**AKVIS Enhancer** is image enhancement software that detects detail in underexposed, overexposed and mid tone...
areas of a photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you improve color and adjust tones. More...

AKVIS Frames — Decorate Your Photos with Frames

(Windows | Mac)

**AKVIS Frames** is free software designed for working with the AKVIS frame packs. Using the program it’s easy to decorate your photos with exclusive picture frames! More...

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

(Windows | Mac)

**AKVIS HDRFactory** lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can also be used for photo correction. The program brings life and color to your photos! More...
**AKVIS LightShop — Light and Star Effects**
(Windows | Mac)

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your pictures! More...

![AKVIS LightShop examples](image1.png)

**AKVIS Magnifier — Change Image Size without Quality Loss**
(Windows | Mac)

AKVIS Magnifier helps to resize images without loss in quality. Whether creating poster-size images, adding resolution for printing an enlargement, or reducing image size, Magnifier will make your prints look sharper and better defined. More...

![AKVIS Magnifier examples](image2.png)
**AKVIS MakeUp — Retouch Your Portrait Photos!**

(Windows | Mac)

**AKVIS MakeUp** improves your portraits giving them a professional look. The software retouches facial imperfections making your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in every photo with AKVIS MakeUp! More...

---

**AKVIS NatureArt — Bring Nature to Your Photos**

(Windows | Mac)

**AKVIS NatureArt** is an excellent tool for imitating the magnificence of natural phenomena on your photos. Add dramatic nature effects to your photo, change the weather on it! With NatureArt you can become a wizard! More...
AKVIS Neon — Glowing Drawings from Photos

(Windows | Mac)

**AKVIS Neon** lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like drawn with luminescent ink. [More...](#)

AKVIS Noise — Digital Noise Reduction

(Windows | Mac)

**AKVIS Noise Buster** is software for noise suppression on digital and scanned images. Digital noise can be seen as artifacts and random red and blue pixels that compromise the smoothness of a photo. The program is efficient against both color and luminance noise. [More...](#)
AKVIS OilPaint — Oil Painting Effect
(Windows | Mac)

**AKVIS OilPaint** turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a painter! More...

AKVIS Pastel — Turn Photos into Pastel Paintings
(Windows | Mac)

**AKVIS Pastel** turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More...
AKVIS Points — Apply Pointillism Effect to Your Photos
(Windows | Mac)

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! More...

![Sunflower Pointillism Effect](image1.jpg)

AKVIS Refocus — Focus Improvement & Blur Effects
(Windows | Mac)

AKVIS Refocus improves sharpness of out of focus images. The program can process the entire photo or bring into focus only the selected part to make the subject stand out against the background. It's also possible to add bokeh and lens blur effects to your photos. The software works in five modes: Refocus, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More...

![Focus Improvement Effect](image2.jpg)

AKVIS Retoucher — Image Restoration Software
(Windows | Mac)

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches, stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the information of the surrounding areas. More...
AKVIS Sketch — Convert a Photo to a Pencil Sketch
(Windows | Mac)

**AKVIS Sketch** converts digital photos to amazing pencil sketches and watercolor drawings. Now you do not need to handle a pencil to feel like an artist. All you need to create your original work of art is good taste and AKVIS Sketch. More...

AKVIS Charcoal 68

AKVIS SmartMask — Save Time on Complex Selections!
(Windows | Mac)

**AKVIS SmartMask** is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The software considerably increases your productivity. You will be freed from boring work and will have
AKVIS Watercolor — Aquarelle Art from Photos

(Windows | Mac)

**AKVIS Watercolor** easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary images into amazingly realistic aquarelle pieces of art. More...